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Wir gratulieren zu Ihrem Kauf der Bushnell® Outdoor Camera! Die Outdoor Camera 
ist speziell dafür ausgelegt, die Erinnerungen an Ihre besten Abenteuer in der freien 
Natur festzuhalten, denn sie ist wasserfest, staubdicht, stoßfest und für die sichere 
Handhabung mit Gummi versehen. Mit ihrem automatischen Blitz und der Fähigkeit 
zum Nahfokus bietet sie natürlich auch Innenaufnahmen bester Qualität.

Bevor Sie die Kamera benutzen, lesen Sie bitte die in diesem Handbuch gegebenen 
Anweisungen gut durch, und nehmen Sie sich Zeit, sich mit dem Betrieb der Kamera 
und ihren vielen Ausstattungsdetails vertraut zu machen.

 

KURZER LEITFADEN: BUSHNELL DIGITAL-KAMERA FÜR DEN OUTDOOR BEREICH A 11-0013G/Y

1 Batterien einlegen 
und die Speicher-
karte (Option)  
einsetzen

Nach Angabe im Batteriefach am Boden der Kamera 2 AA Alkali- oder Lithium Batterien einlegen. 
Es kann auch eine SD-Karte (Option) für zusätzliche Fotospeicherung in den inneren Kartenschlitz 
mit der Eckkerbung links, in Richtung des LCD-Monitors, eingesetzt werden.

2 Die Kamera 
einschal-ten  

Den Leistungsschalter drücken und loslassen. Wenn die live Vorschau im LCD-Monitor angezeigt  
wird, kann ein Bild geschossen werden. Die Normaleinstellungen sorgen unter den meisten  
Bedingungen für optimale Qualität. Es wird jedoch empfohlen, das gesamte Handbuch durchzulesen,  
damit die vielen verfügbaren Optionen für verschiedene Fotobedingungen und Benutzervorzüge  
vorteilhaft genutzt werden können.

3 Die Menü-
Sprache und 
Datum / Uhrzeit 
ein stellen

Zum Öffnen des Modus-Menüs den OK / Menu-Knopf drücken, dann den rechten Pfeil im  
Tastenfeld. Den „Up”-Pfeil zweimal drücken, bis „Set” (Einstellung) erleuchtet ist, dann mit dem 
rechten Pfeil zur Liste des Einstellungsmenüs gehen. Hinunter zu „Language” (Sprache) gehen, dann 
den rechten Pfeil drücken. Die Sprache wählen und den OK Knopf drücken. Der Monitor kehrt zum 
Einstellungsmenü zurück. Den Pfeil nach unten gedrückt halten, bis “Date & Time” (Datum und 
Uhrzeit) erleuchtet ist (an „File Name” (Dateiname) vorbeigehen), dann den rechten Pfeil drücken. 
Im Bildschirm für die Einstellung von „Date & Time” mit dem rechten / linken Pfeil den Teil von 
“Date / Time” wählen, der geändert werden soll, dann mit dem „Up/Down”Pfeil einstellen. Der 
Buchstabe am Ende der Datumszeile stellt das Dateiformat ein im Format (Y/M/D (J/M/T)) zuerst. 
Die Uhrzeit kann im Format 12 oder 24 Stunde eingestellt werden. Nach der Einstellung von “Date 
& Time” OK drücken.  

4 Die SD-Karte 
formatie-ren  
(Option)

Wenn weiter oben eine SD-Karte eingesetzt wurde, muß sie vor der Benutzung der Kamera formatiert 
werden. Im Einstellungsmenu auf „Format” gehen und die rechte Pfeiltaste drücken. Hinunter zu 
„Yes” (Ja) gehen und mit Drücken von  OK bestätigen, daß die Karte formatiert werden soll. Mit 
Drücken von OK wird aus allen Menüs ausgestiegen.

Bitte halten Sie fest, daß die Kamera zwar wetterfest ist, (JIS Grad 4 Wasserfestigkeit),  
daß sie jedoch nicht unter Wasser oder untergetaucht oder mit einem starken  
Wasserstrahl gespült werden sollte. Schaden aufgrund von falscher Benutzung wird 
von der Garantie nicht gedeckt. 
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7. LCD Monitor 14. SD-Karten-schlitz

8. Ein / Aus Knopf 15. Quick View Knopf

9. Sucher-okular 16. Stativ-gewinde

10. 4-Wege Tastenfeld 17. Tragriemen-befestigung

11. OK / Menü-Knopf

12. Batterie-fachdeckel

13. Batterien (AA x 2)

KURZER LEITFADEN: BUSHNELL DIGITAL-KAMERA FÜR DEN OUTDOOR BEREICH A 11-0013G/Y

5 Ein Foto  
aufnehmen

Den Auslöserknopf halb nach unten drücken, um den Autofokus einzustellen (Das grüne AF Licht  
geht an), dann ganz nach unten drücken, sobald das Foto aufgenommen werden soll. Die  
Markierungen in der Mitte des LCD-Monitors zeigen den Bereich, der für die Fokussiereinstellung 
benutzt wurde. Bei sich außerhalb der Mitte befindlichen Objekten diesen Rahmen über das 
Hauptobjekt plazieren, den Auslöserknopf so weit nach unten drücken, bis das AF Licht angeht, ihn 
weiterhin festhalten, dann  die Kamera so bewegen, daß das Bild wieder hergestellt wird,  bevor der 
Auslöserknopf für die Bildaufnahme vollkommen gedrückt wird. Es sind Szenenvoreinstellungen 
für Landschaften,  Bewegtaufnahmen und Porträts sind verfügbar,  siehe ausführliche Anweisungen 
im „Inside the Mode Menu” („Im Modus-Menü).

6 Fotos über-prüfen 
und löschen

“Quick View” (Schnellansicht) drücken (festhalten) und somit die gespeicherten Fotos überprüfen. 
Mit der linken / rechten Pfeiltaste kann man in den Fotos vorwärts- und rückwärts gehen. Die „Up/
Down”Pfeiltaste zoomen ein /aus zur genaueren Betrachtung von Details im Foto. Für das Löschen 
eines Fotos während der Überprüfung kurz „Quick View” drücken (Das Mülleimer-Icon erscheint). 
Mit dem „Down”-Pfeil „Yes” wählen, dann zum Löschen des Fotos „OK” wählen. Für den Ausstieg 
aus der Fotoüberprüfung „Quick View” drücken und festhalten.

7 An einen  
Computer  
anschlie-ßen  
und Fotos  
über-mitteln

Vor dem Anschließen der Kamera die Treiber von der CD-ROM installieren, wenn Windows 
98/98SE benutzt wird und PhotoSuite installieren, wenn noch keine Foto-Software vorhanden ist. 
Das mitgelieferte USB-Kabel vom PC zum USB-Port unter dem Anschlußdeckel (oberhalb des 
Tragriemens) anschließen. Auf der Kamera „OK” drücken. Bei installiertem Windows XP nur die 
Anweisungen / Optionen im Bildschirm befolgen. Bei Windows 98 oder 2000 “My Computer” 
(Mein Computer) auf dem PC öffnen. Die Kamera wird als „Removable Disk” (Herausnehmbare 
Festplatte) erkannt. Doppelklick auf diese „disk” (Festplatte) und die Ordner darauf öffnen. Eine 
der „.jpg” Dateien oder alle wählen und mit  „Edit >Move (or Copy) to Folder” (Bearbeiten>In den 
Ordner verlegen (oder kopieren)die Fotos auf „My Pictures” (Meine Bilder) oder einen anderen  
Ordner auf der Festplatte sichern. Nach der Übermittlung kann die Kamera vom Computer  
abgetrennt werden, und mit der mitgelieferten PhotoSuite können die Ordner geöffnet,  
bearbeitet und erneut gesichert werden. Siehe “Downloading Your Photos Step by Step” (Die Fotos 
herunterladen - Schritt für Schritt) für weitere Details.

Identifizierung Der Teile

1. Auslöser

2. Sucher-okular

3. Blitzgerät

4. Anschluß-deckel

5. Linse

6. Selbst-auslöser- Lampe
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Die Icons Im LCD Monitor Nr. Anzeiger Icons

6 Datums-anzeige 2004.06.20

7 Bild-qualität (Verdich-tung) FQ / NQ / EQ 

8 Bild-größe 
(Aufl ö-sung)

2048x1536, 1600x1200, 1280x960, 
1024x768, 800x600  

9 Sperre digitales Zoom 
 

10 Selbst-auslöser
  

11 Makro

12 Sequenz-aufnahme (3 Rahmen)

13 Bewegt-bildauf-nahme

14 Weiß-abgleich

15 Meßzelle Mitte           Durch-schnitt

16 ISO Ein-stellung AUTO ISO100 ISO200 ISO400

17 Lichtwert (EV) -2 ~ +2

18 Auto Fokus Bereich-anzeiger

Batterien Einlegen  

Eine SD-Karte Einsetzen 

Die Entriegelung wie rechts abgebildet in Richtung des 
Stativgewindes schieben, dann den Batteriefachdeckel öffnen. 
2 AA Alkalibatterien wie angegeben in die Kamera einlegen, 
dann den Batteriefachdeckel bis zum Einrasten schließen.

Die Kamera speichert je nach den Einstellungen für Aufl ösung und 
Qualität 10 bis 271 Fotos im integrierten 16 MB Speicher (siehe die 
Tabelle auf der Rückseite dieses Handbuchs). Zur Erweiterung der 
verfügbaren Speicherkapazität kann als Option eine SD-Speicherkarte 
(„Secure Digital”) mit einer beliebigen Kapazität bis 512 MB eingesetzt 
werden. Die Karte wird in einen Schlitz im Batteriefach wie auf dem 
letzten Diagramm gezeigt eingesetzt. Es wird darauf hingewiesen, 
daß die „gekerbte” Ecke links mit den Metallanschlüssen nach oben 
eingesetzt wird.

Nr. Anzeiger Icons

1 Batterie-kontrolle

2 Aufnahme-modus (Szene)

3 Blitz-modus AUTO

4 SD-Karte einge-setzt “SD”

5 Anzahl verblei-bende Fotos [ 999]
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Ein Foto Aufnehmen
Zum Einschalten der Kamera den Ein- / Aus-Knopf 2 Sekunden lang gedrückt  
festhalten. Der LCD Start-Monitor erscheint, und der rote Ladungsanzeiger blinkt 
kurz auf. Wenn die live Bildvorschau (1) erscheint,  ist die Kamera aufnahmebereit.  
Das Foto auf dem LCD Monitor komponieren (oder den Sucher benutzen, wenn  
der LCD schlecht zu sehen ist oder die Batterie schwach sind). Den Auslöser halb  
herunterdrücken, und somit den Autofokus im mittigen Bereich einstellen, der von 
den AF Markierungen (2) angegeben wird. Wenn der Fokus abgeschlossen ist, geht  
das grüne AF Licht im Sucher an, und die AF Markierungen auf dem LCD  
Monitor gehen von Rot auf Grün über (Es kann ein Foto geschossen werden, solange  
die Markierungen noch rot sind, es ist aber eventuell nicht scharf ). Bei sich  
außerhalb der Mitte befindlichen Objekten den Fokus mit dem AF Bereich in der Mitte 
einstellen, dann die Kamera wie gewünscht bewegen und dabei den Auslöserknopf 
weiterhin auf halber Höhe festhalten. Wenn das Foto aufgenommen werden soll, 
den Auslöserknopf ganz nach unten drücken. (3) Nach der Aufnahme zeigt der LCD 
Monitor automatisch eine rasche Prüfung. (Die Prüfdauer kann in den Einstellungen 
des Modus-Menüs geändert werden). Wenn der LCD Monitor abgeschaltet werden 
soll, um Energie zu sparen, den „Quick View” Knopf rasch zweimal drücken (beim 
Festhalten im gedrückten Zustand geht er zum Modus Photo Review über).

1

2 3

Den Digitalen Zoom Benutzen
Für das Einzoomen die Taste “T” (Telefoto) auf dem  Pfeilfeld drücken  drücken (bis zu 4-fach digital). Wenn  
nach dem Beginn des Einzoomens die „W” Taste (wide) (breit)   gedrückt wird, kehrt das Zoom zur normalen  
Vergrößerung zurück. HINWEIS: Bei hoher Einstellung des digitalen Zooms kann das Vorschaubild aufgrund der  
Begrenzungen der Verarbeitung in Echtzeit “grob” oder weich erscheinen. Dies stellt nicht die tatsächliche Qualität  
des erfaßten Bildes dar, wie aus der Schnellansicht hervorgeht, nachdem das Foto aufgenommen wurde. Wenn der AF 
Anzeiger grün wird, bestätigt dies, daß der Fokus fest eingestellt ist, und das Objekt wird im endgültigen Foto so scharf wie 
möglich sein.

Das Blitzgerät Benutzen

Makro-Fokus Und Selbstauslöser Benutzen

Beim Einschalten der Kamera ist die normale Einstellung “Auto Flash”, (automatisches Blitzen), was bedeutet, daß das 
Blitzgerät nur bei Bedarf unter schwachen Lichtverhältnissen blitzt. Mit Drücken des rechten Feldes auf dem 4-Wege-
Tastenfeld   werden andere Optionen gewählt: Verringerung der “roten Augen” “ (kurzer Vorblitz zur  
Reduzierung der Pupillengröße bei Porträts), „Flash On”  “ (Blitzgerät an), (zwingt das Blitzgerät zum Blitzen  
unter hellen Lichtverhältnissen, um Schatten auf dem Gesicht einer Person mit der Sonne dahinter auszufüllen), und „Flash 
Off”  (Blitzgerät aus), (blitzt unter keinen Lichtverhältnissen – nützlich in Museen oder Theatern, wo das Blitzen 
verboten ist). Das der aktuellen Blitzeinstellung entsprechende Icon wird im LCD Monitor angezeigt (siehe „LCD Display 
Icons), (Icons im LCD Monitor). HINWEIS: Bei “normal” Auto Flash ist kein Icon zu sehen. Nach Aufnahme eines Fotos 
mit Blitz tritt eine Verzögerung von mehreren Sekunden ein, bevor das nächste Foto aufgenommen werden kann, da die 
Blitzlichtschaltungen wieder aufgeladen werden.

Markierung des  
Bereichs für Autofokus  

   Mit dem Makro-Fokus können Nahaufnahmen eines Objekts in einem Abstand von ca. (10 – 60 cm) 
angefertigt werden. Für die Einstellung der Kamera auf den Modus Makro-Fokus den linken Knopf  
des Tastenfelds drücken.   Das Makro- / Timer-Menü wird im LCD Monitor angezeigt. Bei  
hervorgehobenem Makro-Icon (Blume) für die Auswahl “OK” drücken. Das Makro-Icon ist im Vorschau-
Monitor zu sehen. Bei Aufnahmen im Makro-Modus sichergehen, die Kamera still zu halten und auf das 
Autofokus-Licht warten. Für die Rückkehr zum normalen Fokusbereich den linken Knopf des Tastenfelds 
drücken, erneut Makro wählen und „OK” drücken. 
  Im Makro- / Timer-Menü werden beim Drücken des „Down”-Pfeils des Tastenfelds die Optionen des 
Selbstauslösers hervorgehoben, damit man sich selbst in das Foto einbeziehen kann. Die Verzögerungen 
von 3  oder 10  Sekunden sind verfügbar. Bei der gewünschten Dauer “OK” drücken. Bei einer 
Kamera auf einem Stativ oder einer robusten Fläche den Auslöserknopf drücken – der Verschluß schnappt 
nach Ablauf der Dauer ein. Der Selbstauslöser ist auch zur Vermeidung von Bewegungen der Kamera bei 
Nachtaufnahmen nützlich, denn die Kamera arbeitet mit langsameren Geschwindigkeiten des Verschlusses. 
Für die Rückkehr zum normalen Betrieb des Verschlusses den linken Tastenknopf drücken, den aktuellen 
Selbstauslöser wählen und „OK” drücken.
   Im Makro- / Timer-Menü „Cancel” (Löschen), um ohne eine Auswahl auszusteigen.

Makro- / 
Timer-
Menü  
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Das Top Menü Benutzen
Beim Drücken des “OK/Menu” (OK / Menü)  Knopfes unter dem Pfeiltastenfeld 
werden die Wahlmöglichkeiten des Top Menüs im LCD Monitor angezeigt. Es gibt 2 
„Shortcut” (Abkürzung) Menüs, mit denen Größe und Qualität der Fotos rasch geändert 
oder auf den Bewegtbild-Modus umgeschaltet werden kann, sowie ein Modus-Menü, das  
viele in Gruppen oder „Tabs” eingeordnete Einstellungen enthält. Für den Eintritt in  
das Menü den Knopf des Tastenfelds in der gleichen Richtung des Icons drücken.  
Nachstehend die Menüs und ihre Funktionen:

Menü Icon Aktion
Bewegt-bild-
Modus /
Stand-foto-
Modus

         vom Foto-Modus  
          
          vom Bewegtbild-

Modus

Schaltet für die Aufnahme von Video-Clips vom Standfoto  
zum Bewegtbild-Modus um (avi Format). Für die Rückkehr  
vom Bewegtbild-Modus zum Standbild-Modus erneut die „Up”-
Pfeiltaste drücken.

Größe und 
Qualität des 
Bildes 

Die Bildgröße (Dateigröße) kann in 5 Schritten von 2048 x 1536 bis 
herunter auf 800 x 600 Pixel (Bildpunkte) eingestellt werden. Größere 
Bilder haben eine höhere Auflösung (Schärfe), belegen aber mehr 
Speicherkapazität. Die Bildqualität kann von „FQ” (fine quality), 
(feine Qualität) auf „NQ” (normal) oder „EQ” (economy), (Sparen) 
eingestellt werden. Dies betrifft den Umfang der Kompression der .jpg 
Dateien, wobei “FQ” die geringste Kompression / höchste Qualität /  
größte Datei darstellt. Die Einstellungen auf geringere Größe /  
Qualität verbrauchen weniger Speicherplatz, wenn im voraus bekannt 
ist, daß nur kleine Ausdrucke angefertigt oder die Fotos per E-Mail 
verschickt werden sollen.

Anzeige der  
Menüpunkte 

Menü Icon Aktion
Modus-Menu Öffnet weitere Menüs wie  

nachstehend beschrieben.

Das Top Menü Benutzen fortsetzung

Im Modus-Menü – Zusätzliche Einstellungen

Bildschirm des Modus-
Menüs mit (von links 
nach rechts) den Spalten  
Gruppe, Punkt und  
Einstellung. Sich darin  
mit dem 4-Wege- 
Tastenfeld in beliebiger 
Richtung bewegen. 

Wenn nach dem Drücken des “OK/Menu” Knopfes die 3 Top Menüs  
angesehen werden sollen, mit dem rechten Knopf des Tastenfelds das Modus-
Menü öffnen. Die Menüpunkte im Menü-Modus sind in 3 Gruppen oder 
„tabs” eingeordnet, wie in der linken Spalte im Bildschirm des Menü-Modus 
zu sehen ist. Mit dem „Up/Down”-Knopf” ein Menügruppe wählen. Dann 
mit Drücken des rechten Knopfes zur zweiten Spalte übergehen, in der die 
Punkte in dieser Gruppe angezeigt werden. Erneut mit dem „Up/Down”- 
Knopf zum gewünschten Punkt gehen, dann mit Drücken des rechten  
Knopfes zur dritten Spalte übergehen und die verfügbaren Einstellungen  
für diesen Punkt ansehen. Mit dem „Up/Down”-Knopf die gewünschte  
Einstellung wählen, und dann zur Bestätigung den “OK/Menu” Knopf 
drücken. Nach Abschluß der Einstellungen weiterhin den “OK/Menu” 
Knopf bis zur Rückkehr der  normalen Anzeige drücken. Die Gruppen  
des Menü-Modus und die jeweils darin enthaltenen Untermenüs mit  
Punkten und Einstellungen sind in nachstehender Reihenfolge geordnet  
(Die Normaleinstellungen sind in Fettdruck):

Hinweis: Im Größenmenü 
wird nur die erste  
Nummer angezeigt:
2048 x 1536
1600 x 1280
1280 x 960
1024 x 768
800 x 600
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Im Menü-modus – Gruppen / Punkte / Einstellungen
Gruppe Pkt Einstel-lungen Beschreibung

1: Belich-tung Szene P (Programm) Automatische Standardbelichtung für normale Fotos

Land- 
schaft        

Mehr Tiefenschärfe für erweiterte Schärfe von Vorder- bis zum Hintergrund

Porträt      
Geringe Tiefenschärfe für Fotos von Leuten – hilft bei der Trennung des Objekts 
vom Hintergrund.

Aktion     
Benutzt höhere Geschwindigkeiten des Verschlusses, um beim „Einfrieren” der 
Bewegung zu helfen

Nacht       
Benutzt geringere Geschwindigkeiten des Verschlusses für bessere Belichtung bei 
schwachem Licht

Messen Mitte Die Kamera stellt die Belichtung meistens auf Grundlage der Rahmenmitte  
ein. Nützlich, wenn die Helligkeit des Hauptobjekts stark von derjenigen des 
Hintergrunds abweicht.

Durch-schnitt Die Kamera stellt die Belichtung nach dem Gesamtbild ein. Kein Icon im LCD Monitor.

ISO Auto Die Lichtempfindlichkeit wird automatisch von ISO 100 – 400 eingestellt. 

100/200/400 Manuelle Einstellungen. Höhere ISO-Werte nur für schwache  
Lichtverhältnisse benutzen.

EV -2.0 ~ +2.0 Bietet manuelle Anpassung der Über-/ Unterbelichtung in 0,3 EV Schritten.

2: Farbe WB Auto (A) Der Weißabgleich wird automatisch für die richtige Farbwiedergabe eingestellt. 

Tageslicht        Manuelle Einstellung für Outdoor mit Sonne

Gruppe Pkt Einstel-lungen Beschreibung

Wolkig     Manuelle Einstellung für Bewölkung oder Schatten Outdoor

Tungsten  
Manuelle Einstellung für Tungsten-Beleuchtung Indoor (Glühlampe)

Fluores- 
zierend     

Manuelle Einstellung für Leuchtstofflampe Indoor

Farb modus Farbe Normale Farbwiedergabe 

Schwarz - weiß Nur für Schwarz – Weiß-Fotografie

Sepia Spezieller Effekt für den  “antikgetönten” Look der Fotos

Kontrast Stark Verstärkter Kontrast an bewölkten Tagen oder flache Beleuchtung

Normal Durchschnittlicher Kontrast für die meisten Szenen

Gering Reduzierter Kontrast für die Tagesmitte oder andere Umstände mit  
hohem Kontrast 

3: Einstellung Alles  
zurückstellen

Nein / Ja “Yes” wählen und den “OK/Menu”-Knopf drücken, damit alle  
Einstellungen des Benutzers gelöscht und die normalen Einstellungen  
wieder hergestellt werden.

Format Nein / Ja “Yes” wählen, dann den “OK/Menu”-Knopf drücken, um eine eingesetzte  
SD-Karte (Option) zu formatieren (vorzubereiten). Achtung: Dies löscht alle 
vorher auf der Karte gespeicherten Dateien. 

Im Menü-modus – Gruppen / Punkte / Einstellungen fortsetzung
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Im Menü-modus – Gruppen / Punkte / Einstellungen fortsetzung
Gruppe Pkt Einstel-lungen Beschreibung

3: Einstellung Sprache Englisch/Spanisch/ 
Französisch/Deutsch/ 
Italienisch/Portugiesisch

Wählt die in allen Menüs angezeigte Sprache aus

Aufnahme 
Ansicht

Aus, 1, 2 oder 3 Sek. Stellt die Anzeigedauer der Fotoüberprüfung nach der Aufnahme des Fotos ein

Dateiname Rückstellung  
oder Serien

Die Nummerierung der Dateien für neue Fotos nach dem vollständigen 
Löschen beginnt wieder bei „1” (Reset), (Rückstellung), oder fährt nach der 
letzten benutzten Nummer fort (Serien).

LCD  
Helligkeit 

Einstellung auf eine  
von 7 Stufen

Stellt die Helligkeit des Monitors ein. Linker Rahmen = dunkler, rechter 
Rahmen = heller. Der mittlere Rahmen steht für die Normalstufe. Für die 
Einstellung „OK” drücken.

Datum und 
Timer

> zum Setup gehen. 
Nach der Einstellung 
“OK” drücken.

Mit der linken / rechten Taste zur Bewegung zwischen den  Feldern. „Up/
Down”-Pfeil für die Änderung der Einstellung. Der Buchstabe nach dem Datum 
stellt das Format ein: M, T oder J zuerst.

Video-Ausgang NTSC oder PAL Betrifft das Video-Ausgangssignal. Für das örtliche TV-System eingestellt.

Aufnahme-
Modus

1-Bild oder 3-Bilder Stellt die Anzahl Fotos ein, die bei jedem Drücken des Auslösers aufgenommen 
werden. 1-Bild ist die normale Einzelaufnahme,  bei 3-Bilder werden in rascher 
Serie 3 Fotos aufgenommen, um eine Bewegungsfolge einzufangen.

Speicherung Auto Die Dateien werden auf der SD-Karte gespeichert, wenn eine eingesetzt wurde, 
andernfalls im RAM Speicher.  

SD-Karte Die Dateien werden nur auf der SD-Karte gespeichert (muß eingesetzt werden).

Intern Die Dateien we rden nur im internen Speicher abgelegt, niemals auf einer Karte. 

Gespeicherte Fotos Überprüfen Und Löschen
Für die Überprüfung (Playback) der im internen Speicher oder auf der SD-Karte gespeicherten Fotos “Quick View” 
Knopf drücken und festhalten, bis der Monitor das vorherige Foto anzeigt. Mit dem linken / rechten Knopf des 
Tastenfelds die Fotos rückwärts oder vorwärts blättern. Wenn ein Foto angezeigt wird, wird beim Drücken des 
“Up” Knopfes mit dem Zoomen des Bildes begonnen (bis zu 4-facher Vergrößerung), was für die Überprüfung 
der Schärfe des Fotos nützlich ist. Nach dem Zoomen kann „OK” gedrückt werden, (und für den Ausstieg erneut 
„OK”). Nach dem Zoomen mit Drücken des “Down”-Knopfes wieder zurückgehen. Das Drücken des „Down”- 
Knopfes bei normal angezeigtem Foto (ohne Zoom) führt zu einer Übersicht von mehreren Fotos (bis zu 9  
gleichzeitig), wobei Kleinbilder aller Fotos angezeigt werden. Dann kann unter Benutzung des Tastenfelds ein spezifisches  
Foto hervorgehoben und mit Drücken des “OK/Menu”-Knopfes auf dem ganzen Monitor angezeigt werden.  
Zum Löschen (Vernichten) eines Fotos während der Überprüfung kurz den “Quick View” Knopf drücken (nicht 
festhalten). Das Lösch-Menü erscheint mit einer Auswahl unter „One” (Eins) oder „All” (Alle). Den „Down”-Knopf  
drücken (“Eins” wählen), dann “OK” zum Löschen nur dieses Fotos. Beim Löschen des / der Fotos ist eine  
“Sanduhr” zu sehen. Es wird darauf hingewiesen, daß beim Drücken des “OK” Knopfes nach dem Wählen von 
“One” oder “All” Foto(s) das Vernichten sofort erfolgt, also darauf achten, nicht „All” zu wählen, wenn die Fotos 
nicht vorher an den PC übermittelt wurden. Nach dem Abschluß der Überprüfung der Fotos den “Quick View”-
Knopf drücken und festhalten, um zur live Anzeige der Vorschau zurückzukehren.

Überprüfungs-Menüs
Nach dem Drücken des “Quick View”-Knopfes zum Einstieg in den 
Überprüfungs-Modus führt das Drücken des “OK/Menu”-Knopfes zu den 
Überprüfungs-Menüs. Diese funktionieren genauso wie vorher bei den 
Menüanweisungen des Standfoto-Modus beschrieben (für die Navigation 
zum gewünschten Menü die Pfeile des Tastenfeld benutzen, zur Bestätigung 
einer Einstellung „OK” drücken), jedoch mit verschiedenen Menüpunkten 
und Einstellungen wie folgt:

Überprüfungs-Modus:   
Anzeige des Top Menüs
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Menü Icon Aktion

Dia-Show  Durchläuft automatisch gespeicherte Fotos ab den ältesten. Die “Up/Down”-Pfeiltaste drücken, 
um mit der Dia-Show zu beginnen. Sie endet mit dem jüngsten aufgenommenen Foto und kehrt 
zum normalen Überprüfungs-Modus zurück.

Info Stellt ein, ob die Information (Dateinummer, Bildgröße und –qualität, Datum / Uhrzeit im  
Überprüfungs-Modus zu jedem Foto angezeigt wird oder nicht. Die gespeicherte Information 
wird nicht ständig betroffen. 

Menüs des 
Überprüfungs-
Modus

Öffnen zusätzliche Einstellungen wie im nächsten Abschnitt beschrieben.

Überprüfungs-Menüs  fortsetzung

Menüeinstellungen Des Überprüfungs-Modus
Gruppe Pkt Ein stellungen Beschreibung

1: Abspielen Schutz Aus / An Bei Einstellung auf “On” wird die Fähigkeit zum Löschen von Fotos 
gesperrt, bis in diesem Menü wieder „Aus” gewählt wird. Verhindern 
automatisches Löschen.

Drehen   90 Grad > oder < Dreht die Anzeige überprüfter Fotos. Vermeidet, daß die Kamera bei der 
Überprüfung der mit senkrecht gehaltener Kamera aufgenommene Bilder 
gedreht werden muß (Porträts stehender Objekte, usw.) 

2: Farbe Schwarz - Weiß Aus / An Legt eine weitere Schwarz – Weiß-Version (neue Datei) ausgehend vom im 
Moment überprüften Foto an (dauert einige Sekunden). Die ursprüngliche 
Farbfoto-Datei wird davon nicht betroffen.

Gruppe Pkt Ein stellungen Beschreibung

Sepia Aus / An Siehe die Beschreibung zu Schwarz – Weiß. Mit Effekt des Sepia-Farbtons.

Auf die SD-Karte 
kopieren

Nein / Ja Kopiert den gesamten Inhalt des internen Speichers auf die SD-Karte.

Format Nein / Ja Formatiert die eingesetzte SD-Karte und löscht dabei ihren vorhandenen Inhalt.

3: Einstellung Alle rückstellen Nein / Ja “Yes” wählen und den “OK/Menu”-Knopf drücken, um alle Einstellungen des 
Benutzers zu löschen und die normalen Einstellungen wieder herzustellen.

Sprache Wie vorher im Abschnitt über das Photomodus-Menü beschrieben

LCD Helligkeit Wie vorher im Abschnitt über das Photomodus-Menü beschrieben

Datum und Uhrzeit Wie vorher im Abschnitt über das Photomodus-Menü beschrieben

Video Ausgang Wie vorher im Abschnitt über das Photomodus-Menü beschrieben

Menüeinstellungen Des Überprüfungs-Modus fortsetzung

Bewegtaufnahmen-Modus Und Menüs
Im Fotomodus bei angezeigter live Vorschau “OK/Menu” drücken, um zu den Top Menüs zu gelangen. Für den 
Übergang zum Bewegtaufnahmen-Modus den „Up”-Knopf des Tastenfelds drücken. Das Icon für Bewegtaufnahmen 
       Wird angezeigt. Mit Drücken von „OK/Menu” die Auflösung „320” oder „160” wählen, und dann den linken Pfeil 
drücken. Den Auslöserknopf drücken, um mit der Aufnahme eines Video-Clips zu beginnen (avi Format), und dann 
zum Abbruch des Videos erneut drücken. Zum Abspielen des Videos den „Quick View” drücken und festhalten, bis 
der Monitor zu „Review” übergeht (die erste Aufnahme des Films ist zu sehen ). Zum Abspielen den Auslöserknopf 
drücken. Kurz “Quick View” drücken und zum “Delete”-Menü (löschen) übergehen. Nach dem Aufnehmen von 
Videos “OK” für das Top Menü drücken, dann den “Up”-Knopf (Standbild-Icon), um zum normalen Foto-Modus  
zurückzukehren. Es wird auf folgende Unterschiede in den Optionen für Menü- und Merkmale zwischen dem  
Bewegtaufnahmen-Modus und dem Fotomodus hingewiesen:
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Erforderliches System (Minimum)

Installation Der Software 

Die Fotos Herunterladen – Schritt Für Schritt

OS: Windows® 98/98SE/2000/ME/XP
Zentraleinheit: MMX Pentium® 200 MHZ gleichwertig oder schneller Pentium® III 500 MHz für PhotoSuite5™)
Speicher: 32 MB Minimum (64 MB für PhotoSuite empfohlen)
SVGA Videokarte w/2 MB VRAM, 800 x 600 Bildschirmanzeige, 16 Bit High color
200 MB verfügbarer Speicherplatz auf der Festplatte (wenn PhotoSuite installiert wird)
Interner USB Port

Wenn Windows 98 benutzt wird, müssen vor dem Anschluß der Kamera an den  Computer Treiber installiert werden. Die 
CD-ROM in das CD Laufwerk des Computers einlegen; sie läuft automatisch, und der Bildschirm für die Installation wird 
angezeigt. „Install Driver” wählen, dann die Anweisungen befolgen. Den Computer nach der Installation neu starten. Für 
Windows 2000, ME und XP sind keine Treiber erforderlich, da die Kamera mit dem USB Massenspeicher-Standard arbeitet,  
damit auf die Fotodateien so zugegriffen werden kann, als ob sie auf einer externen Festplatte gespeichert wären. Wenn  
noch keine Fotobearbeitungs-Software vorhanden ist, kann bei jedem Windows OS Roxio PhotoSuite® von der CD-ROM  
installiert werden. Sichergehen, die „Release Notes” (Hinweise zur Ausgabe) vollständig durchlesen und alle für den  
Computer und die OS relevanten Tips oder potentiellen Punkte festhalten.

1. Bei einem Computer mit Windows 98/98SE sichergehen, daß der Treiber zuerst installiert worden ist.
2. Die Kamera einschalten und das mitgelieferte USB Kabel an die USB Buchse der Kamera anschließen 
(den Anschlußdeckel auf der Seite des Trageriemens öffnen), dann direkt an den USB Port des Computers 
– keine USB Ports an der Frontplatte / auf der Tastatur oder „hubs” ohne Stromversorgung benutzen. 
3. Die Kamera zeigt den Übermittlungs-Bildschirm an, und das PC Icon ist hervorgehoben. „OK”  
drücken, und der Bildschirm geht zu „Mass Storage” (Massenspeicher) über. Andernfalls alle offenen  
Programme schließen, die Kamera abtrennen, den Computer erneut starten und noch einmal versuchen.

Bildschirm 
beim  

Herunterladen  

Bewegtaufnahmen-Modus Und Menüs fortsetzung 
Im Bewegtaufnahmen-Modus sind alle Merkmale und Menüoptionen 
identisch mit denjenigen im normalen Standbild-Modus mit  
nachstehenden Ausnahmen:
• Es sind keine voreingestellten Optionen für Szenen verfügbar (Landschaft, Porträt, usw.).
• Keine Optionen des Aufnahmemodus (3 x Folge).
•  Die verfügbaren Optionen für die Bildgröße sind 320 x 240 oder 160 x 120. Dies stellt die Auflösung  

der Bewegtaufnahmen pro Bild ein. Der Übergang zur 160 x 120 Auflösung bietet die 4-fache  
Aufnahmezeit gegenüber 320 x 240, jedoch mit geringerer Qualität. Der Bildablauf ist auf 20 Bilder pro  
Sekunde voreingestellt.

•  Es sind keine Optionen für die Qualität (Kompression der Dateien) vorhanden.
•  Vor der Aufnahme eines Videos zeigt der Zähler unten rechts im LCD Monitor die verfügbare  

Aufnahmedauer in Sekunden an (31”, 124”, usw.).
•  Während der Aufnahme des Videos zeigt der Zähler die abgelaufen en Sekunden an.
•  Digitales Zoom und Makro-Fokus sind nicht verfügbar, das Blitzgerät ist auf “Off” eingestellt. 
•  Wenn die Kamera im Bewegtaufnahmen-Modus abgeschaltet wird, kehrt sie beim erneuten Einschalten 

zum Standfoto-Modus über. 
 
Hinweis: Wenn der PC die .avi Videodateien im Windows Media Player nicht abspielt, kann es erforderlich sein, 
eine neuere Version des Player von Microsoft.com herunterzuladen (nach „media player download” suchen). Die 
Videodateien können auch mit dem QuickTime Player abgespielt werden, der in vielen Computern vorhanden ist 
oder von Apple.com kostenlos heruntergeladen werden kann.
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Den Direkten Ausdruck (Pictbridge) Benutzen
Die Outdoor Kamera unterstützt auch den direkten Ausdruck ab der Kamera auf mit PictBridge 
kompatiblen Druckern ohne Benutzung des PC. Es wird empfohlen, zuerst den Abschnitt des 
Druckerhandbuchs über Direkter Ausdruck / PictBridge durchzulesen. Bei eingeschaltetem 
Drucker das mitgelieferte USB Kabel an die Kamera anschließen, dann zum USB Port für direkten 
Ausdruck an der Vorderseite oder Seite des Druckers. Der Monitor der Kamera sollte erscheinen 
(andernfalls die Kamera abschalten. Das Drucker Icon wählen (1) und “OK” drücken. Nach kurzer 
Zeit, in der die Kommunikation zwischen der Kamera und dem Drucker hergestellt wird, kann das 
Menü mit den Druckoptionen (2) der Kamera gesehen werden. Wie üblich mit den „Up/Down” 
Tasten eine Druckoption wählen und „OK” drücken. Nachfolgende Optionen sind vorhanden 
(vom obersten zum untersten Icon):

1

2

1. „Print One” (Eins drucken), (mit der linken / rechten Taste das Bild wählen, mit  
“Up/Down” die gewünschte Anzahl Kopien). Wenn fertig zum Drucken „OK” drücken).
2. „Print All Images” (Alle Bilder drucken), („No/Yes”). Druckt alle in der Kamera  
gespeicherten Bilder.
3. “Print Selected Photo from Thumbnail Review” (Das ausgewählte Bild aus der  
Gesamtabbildung wählen), (mit der linken / rechten Taste ein Foto wählen, mit „Up/Down” 
wählen, wieviele Kopien gewünscht werden). 4. “Print All Images as Index” (Alle Bilder als  
Index drucken), druckt Gesamtabbildungen aller Fotos (“Kontaktabzug”).
5. Aus dem Druckmenü aussteigen.

4. “My Computer” (Mein Computer) oder “Windows Explorer” öffnen. Die Kamera wird als neue „Removable Disk” gesehen 
und ein noch nicht benutzter Buchstabe für den Treiber zugeordnet. Doppelklick auf diese neue „Festplatte”, den “DCIM  
Ordner” innen öffnen, dann  einen (alle)  darin enthaltenen Ordner öffnen („100BUSHN”, usw.). Die Fotos sind die  
darin vorhandenen JPEG Dateien – sie haben das Präfix “BUSH__” mit nachfolgender Nummer, die gleiche wie vorher im 
Monitor der Kamera gesehen, als die Fotos überprüft wurden. Bei Einzelklick auf eine Datei sollte ein kleines Vorschau-Bild 
angezeigt werden.
5. Auf “Edit>Select All” (Bearbeiten>Alle wählen) klicken (oder auf ein Foto klicken, “control” + Klick zur Auswahl mehrerer 
Fotos), dann „Edit>Copy to Folder” (Bearbeiten>In den Ordner kopieren), (in den Windows Menüs). Einen auf der Festplatte 
vorhandenen Ordner wählen wie “My Pictures” (Meine Bilder) oder einen neuen Ordner anlegen („Urlaub 2004”, usw.), dann 
auf „OK” klicken, um Kopien der gewünschten Fotodateien zu übermitteln.
6. Nach der Übermittlung der Fotos auf die Festplatte kann die Kamera abgetrennt werden. Windows kann einen Bildschirm mit 
der Warnung erzeugen, daß eine USB Vorrichtung abgetrennt wurde, ohne die „Festplatte” vorher zu stoppen  oder auszuwerfen. 
(Die Fotodateien werden davon nicht beschädigt). Wenn dies eintritt, die Box prüfen, die ein Icon zur Systemanzeige oder 
Taskleiste hinzufügt. Das nächste Mal kann dann nach der Übermittlung von Fotos zuerst auf dieses Icon und „Stop the USB 
Mass Storage Device” (Den USB Massenspeicher stoppen) geklickt werden, bevor die Kamera abgetrennt wird.
7. Jetzt können die Fotodateien unter jeder beliebigen Bearbeitungs-Software geöffnet werden. Nur „File>Open” (Datei>öffnen) 
benutzen und zum Ordner gehen, in dem die Fotos vorher gespeichert worden waren. Unter PhotoSuite “File>Open Photo” 
(Datei>Foto öffnen) wählen und dann im “Look in” (Hineinschauen) Pull Down Menü oben am Öffnen Fenster “My Computer” 
wählen, den Festplattentreiber wählen und jedes Foto im Ordner doppelt anklicken, in den die Dateien ab der Kamera kopiert 
worden waren. Es ist auch möglich, die Fotos direkt in der Outdoor Kamera zu öffnen und damit zu arbeiten, solange sie noch 
angeschlossen ist. Hierfür unter PhotoSuite zunächst die Schritte 1 bis 3 durchführen, dann PhotoSuite öffnen, “File>Open 
Photo” wählen und im “Look in” Menü “My Computer” wählen, dann die “Removable Disk” wählen und die darin enthaltenen 
Ordner bis zu den JPEG Fotodateien öffnen. Wenn auf diese Weise ab einer angeschlossenen Kamera gearbeitet werden soll, 
sichergehen, daß das Foto vorher auf der Festplatte gesichert wird (nach Abschluß der Bearbeitung) und nicht in den Speicher der 
Kamera oder die Karte. Hierfür unter PhotoSuite zunächst auf “Done” (Fertig) klicken, dann auf “Save Changes?” (Änderungen 
sichern?) mit “Yes” antworten, dann aber auf “Replace Existing File”? (Vorhandene Datei überschreiben?) mit “No” antworten 
und die “Save As” (Sichern als) Dialogbox dazu benutzen, das bearbeitete Foto in einem Ordner auf der Festplatte zu sichern 
(“Save In>Local Disk”), (Sichern in>Lokale Festplatte) und nicht auf “Removable Disk” (Kamera).

Die Fotos Herunterladen – Schritt Für Schritt fortsetzung Die Fotos Herunterladen – Schritt Für Schritt fortsetzung 
8. Ein Anfänger bei der Fotobearbeitung im Computer das Hilfe-Menü der Software nach Tips zur Benutzung ihrer Merkmale 
befragen, (PhotoSuite hat umfangreiche eingebaute Hilfe). Bei der Anpassung von Helligkeit, Kontrast, Schärfe und Farbe 
der Fotos kann das Foto so bemessen werden, daß es bei Ausdruck auf das Papier paßt, und es kann eine kleinere Datei mit 
niedriger oder mittlerer Auflösung gesichert werden, die in E-Mails oder Dokumente eingefügt wird. Wenn die bearbeitete 
Datei gesichert werden soll, kann “Save As” benutzt und ihr ein eher beschreibender Name als “BUSH0001” gegeben werden. 
Hierbei wird auch die Originaldatei als Sicherung erhalten, die später erneut geöffnet und neu bearbeitet wird. Sichergehen, 
daß alle Fotos, die gesichert werden sollten, mit Erfolg übermittelt wurden, bevor “Delete All” (Alles löschen) auf der Kamera 
gewählt wird, um Platz für neue Bilder zu schaffen.
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AUF ZWEI JAHRE BEGRENZTE GARANTIE

Das Bushnell® Produkt ist für zwei Jahre nach dem Kaufdatum frei von Mängeln der 
Werkstoffe und der Ausführung garantiert. Sollte sich unter dieser Garantie ein Mangel 
herausstellen, werden wir nach eigenem Gutdünken das Produkt reparieren oder ersetzen, 
wenn es mit vorher bezahlten Porto eingeschickt wird. Diese Garantie deckt keine Schäden 
durch falsche Benutzung, falsche Handhabung oder Installation durch eine andere Person 
als diejenigen der von Bushnell zugelassenen Serviceabteilung.

Rücksendungen im Rahmen dieser Garantie müssen enthalten:
 1)  Einen Scheck / eine Zahlungsanweisung über $ 10,00 zur Deckung der Gebühren der 

Post und das Handling
 2) Name und Adresse für die Rücksendung des Produkts
 3) Eine Erklärung des Mangels
 4)  Kaufbeleg mit Datum
 5)   Das Produkt sollte gut in einem Versandkarton mit robuster Außenseite verpackt 

werden, damit Schäden beim Transit verhindert werden, und das vorher bezahlte Porto 
muß beigefügt sein. Der Versand geht an nachstehende Adresse:

In den USA an:  In den USA an: 
Bushnell Performance Optics  Bushnell Performance Optics
Attn.:  Repairs   Attn.:  Repairs
8500 Marshall Drive  25A East Pearce Street, Unit 1
Lenexa, Kansas 66214  Richmond Hill, Ontario L4B 2M9

Für außerhalb der Vereinigten Staaten oder Kanadas gekaufte Produkte sich an den örtlichen 
Händler wenden und die gültigen Informationen über die Garantie einholen. In Europa 
kann Bushnell auch an folgender Adresse angesprochen werden:
 BUSHNELL Performance Optics GmbH
 European Service Centre
 MORSESTRASSE 4
 D-50769 KÖLN
 DEUTSCHLAND
 Tel.: +49 (0) 221 709 939 3
 Fax: +49 (0) 221 709 939 8

Diese Garantie verleiht spezifische gesetzliche Rechte.
Es kann je nach Land unterschiedliche andere Rechte geben.

©2004 Bushnell Performance Optics

Bild-
größe

Mega-pixel 
(ca.)

Quali-tät * Inter-ner 
Spei-cher 

64 MB 
SD- Karte

2048x1536 3,2 FQ 10 Fotos 39 Fotos

NQ 20 79

EQ 41 158

1600x1280 2,1 FQ 16 64

NQ 33 129

EQ 67 259

1280x960 1,3 FQ 26 101

NQ 53 202

EQ 106 405

1024x768 0,8 FQ 41 158

NQ 82 317

EQ 165 634

800x600 0,5 FQ 67 259

NQ 135 519

EQ 271 1038

Referenz Für Foto-speicherkapazität  (max. kapazität, +/- 2 fotos)

* Wählt den Umfang der Kompression der Datei 
(jpg Verhältnis)
(FQ = gering / EQ = stark)
FQ: Feine Qualität (1:2,5)
NQ: Normale Qualität (1:5)
EQ: Sparqualität (1:10)

Die Bildgröße bezieht sich auf die Pixel- 
Abmessungen, oder die Auflösung, der  
digitalen Datei. 
 
Die tatsächliche Speicherkapazität schwankt je 
nach Inhalt jeder Fotodatei. Es kann möglich 
sein, einige Fotos mehr oder weniger als mit der 
aufgelisteten Kapazität aufnehmen zu können. 

Eine große Größe und hohe Qualität für  
Fotos einstellen, die später vergrößert oder 
abgeschnitten werden sollen. Sie können bei 
Bedarf auch mit der Foto-Software auf eine 
kleinere Dateigröße reduziert werden. Geringe 
Größe und/oder geringe Qualität einstellen, 
wenn die Fotos nur per E-Mail versandt, in 
Dokumente eingefügt oder kleine Drucke davon 
angefertigt werden sollen und die Datei später 
nicht verändert werden soll.

FCC HINWEIS:
Diese Ausrüstung wurde getestet, und es hat sich 
herausgestellt, daß sie die Grenzen eines digitalen Geräts der 
Klasse B gemäß Teil 15 der FCC Regeln einhält. Diese Regeln 
sollen vernünftigen Schutz gegen schädliche Interferenzen bei 
Installation in einer Wohngegend bieten. Diese Ausrüstung 
generiert und benutzt Funkfrequenzenergie und kann 
sie abstrahlen, und sie kann für Funkkommunikationen 
schädliche Interferenzen verursachen, wenn  sie nicht in 
Übereinstimmung mit den Anweisungen installiert und 
benutzt wird. Es gibt jedoch keine Garantie dafür, daß in 
einer bestimmten Anlage keine Interferenzen entstehen. 
Wenn diese Ausrüstung für den Radio- und Fernsehempfang 
schädliche Interferenzen verursacht, was beim Ein- und 
Ausschalten der Ausrüstung bestimmt werden kann, wird 
der Benutzer aufgefordert, die Interferenz mit einer oder 
mehreren der folgenden Maßnahmen zu beheben:
·  Die Empfangsantenne anders ausrichten oder an einem an 
deren Ort montieren.

·  Den Abstand zwischen der Ausrüstung und dem 
Empfänger vergrößern.

·  Die Ausrüstung an einen Ausgang auf einem anderen 
Schaltkreis anschließen, als demjenigen, an den der 
Empfänger angeschlossen ist.  

·  Den Händler oder einen erfahrenen Radio-/TV-Techniker 
um Hilfe bitten.

Mit der Ausrüstung muß das geschirmte Schnittstellenkabel 
benutzt werden, um die Grenzen für ein digitales Gerät 
gemäß Unterteil B in Teil 15 der FCC Regeln einzuhalten.

Spezifikationen und Auslegungen können seitens des 
Herstellers ohne Vorankündigung oder Verpflichtung 
geändert werden.
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Hinweis: 


